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PLEASE READ THE INSTRUCTIONS IN THE GRAY BOXES CAREFULLY AND USE TRACK CHANGES WHILE MAKING ANY EDITS TO THE DOCUMENT. 
This document has several sections on separate pages, so take care to view each page.


Author Questionnaire:

Authors, please fill out the unanswered questions below.  


1. Microscopy: Does your protocol involve video microscopy, such as filming a complex dissection or microinjection technique? N

2. Does your protocol include software usage? Y
If yes, we will need you to record using screen recording software to capture the steps. If you use a Mac, QuickTime X also has the ability to record the steps. [Will do]

3. Which steps from the protocol section below are the most important for viewers to see? Please list 4-6 individual steps using the step numbers listed in this document. This information is important to prepare your Videographer for your shoot. (You do not need to include steps that will be screen captured. Please do not list entire sections.)
Authors, please answer this question with the steps listed here in the Protocol section below for use by the videographer.2.6
2.7
2.8
2.15
2.17
4.6

4. What is the single most difficult aspect of this procedure and what do you do to ensure success? Please list 1-2 individual steps using the step numbers listed in this document. (Please do not list entire sections.)
Authors, please answer this question with the steps listed here in the Protocol section below for use by the videographer2.7
2.15

5. Will the filming need to take place in multiple locations? N


Section - Introduction
Videographer: Interviewee Headshots are required. Take a headshot for each interviewee.

Authors, these headshots will be used for the JoVE Dedicated Author Webpage. Here is one example if you wish to take a look.

1. REQUIRED Interview Statements: (Said by you on camera)  - All interview statements may be edited for length and clarity.

· The total introduction length (i.e., Required and Optional Interview Statements) cannot exceed 150 words. 
· Restrict the length of each statement to no more than 30 words.
· Please answer the questions below in full sentences to highlight the significance of your protocol. You will be expected to memorize and deliver these sentences as spoken interview statements during filming. 
· Indicate the full name of each author who will give each statement. If only one author is giving the REQUIRED statements, the same author may speak both statements.

Why is your protocol significant? OR What key questions can this method help answer? 

1.1. Author NameSusan L. Forsburg: ___________(Live-cell microscopy allows researchers to study fission yeast mitotic and meiotic nuclear dynamics in real timeWrite your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on camera [1]).
1.1.1. INTERVIEW
1.1.2. 

What is the main advantage of this technique?

1.2. Author NameSusan L. Forsburg:  ___________(The strength of this technique stems from observing nuclear processes in living cells under normal physiological conditions, which eliminates the use of toxic fixatives and stainsWrite your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on camera [1]).
1.2.1. INTERVIEW


OPTIONAL Interview Statements: (Said by you on camera)  - All interview statements may be edited for length and clarity.

· The following OPTIONAL questions may be answered to provide additional introductory information about your protocol. 
· These OPTIONAL statements must be spoken by different authors than those who gave the Required Interview Statements.
· The length of each OPTIONAL statement is restricted to no more than 30 words and contributes to the total introduction length, which cannot exceed 150 words. 
· Indicate the full name of each author who will give each OPTIONAL statement. 



Do the implications of this technique extend toward the therapy (or diagnosis) of a particular disease, disability, or challenge? How so?

1.3. Author NameWilber Escorcia: ___________(Write your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on cameraThis technique addresses questions related to protein timing, mobility, and stability that may not be amenable to genetic or biochemical manipulation). [1].
1.3.1. INTERVIEW
Are there any specific areas of research that this method could provide insight into? 

Can this method be applied to any other systems?

1.4. Author Name: ___________(Write your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on camera)


How would you expect an individual who has never performed this technique to struggle? 

Do you have any advice to offer to somebody who is trying this technique for the first time?

1.5. Author NameWilber Escorcia: ___________ (Write your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on cameraIt is critical to pay close attention to the health and fitness of fission yeast cells before imaging. Always examine cell morphology and growth characteristics to ensure consistency of results across experiments [1]).
1.5.1. INTERVIEW

Why is visual demonstration of this method critical?

1.6. Author NameKuo-Fang Shen: ___________(Write your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on cameraThis protocol shows a relatively simple way to prepare microscope slides that, when mastered correctly, can enhance the consistency and reproducibility of prolonged live-cell imaging [1]).
1.6.1. INTERVIEW


Introduction of Demonstrator: (Said by you on camera)

· Please use this statement ONLY if any of the individuals who will be demonstrating the procedure on camera have not given a required or optional Introduction interview statement already.
· Include the full name(s) of the person(s) demonstrating the experiment followed by their title (e.g., technician, post doc, grad student, clinician, etc.) 
· Also indicate the full name of the author who will introduce the demonstrator(s). 

1.7. Author NameSusan L. Forsburg: Demonstrating the procedure will be _________ (name of the person or personsJi-Ping Yuan), a  _________ (technician, post doc, grad studentlaboratory technician) from my laboratory [1] [2]. (Add additional mention of demonstrators as necessary).  
1.7.1. Interview style: Author saying the above 
1.7.2. The named technician, post doc, student looks up from workbench or desk or microscope and acknowledges the camera.


Section - Introduction
Section - Protocol
· Read through the entire protocol carefully to understand what you will need on the filming day and prepare accordingly. 
· The two-digit numbers (e.g. 2.1., 2.2.) represent the “steps” of you protocol and will be read by a professional voiceover talent. 
· The three-digit numbers (e.g. 2.1.1., 2.2.2.) represent the “shots” that our videographer will capture at your lab. 
· To ensure that your protocol can be filmed in a single work day, the protocol is restricted to 30 steps and/or 60 shots.
· It is critical for a smooth and organized shoot that all materials and work spaces are prepared and labeled (if applicable) in advance.   
· Any specimens/samples that require long or overnight incubation steps should be prepared in advance. (i.e. day 0 sample preparation will be filmed on the day of the shoot; day 1 samples should be prepared the day before the shoot so their processing can be filmed on the day of the shoot/after their overnight culture/treatment/etc.) 
Authors: Please address highlighted questions. If the highlighted areas are correct, you don’t need to change anything. Also check if any pronunciation is incorrect.
Please record time codes for screen captures.
2. Fission Yeast Culture and Sample Preparation
2.1. To begin, streak cell matter on YES (pronounce as Y-E-S, spelled out) plates [1] and incubate them at  25o C or 32o C to wake up fission yeast strains from cryogenic preservationn by adding YES solid medium to the yeast plate [12]. Use a sterile loop to pick cells from individual colonies [2] and inoculate them into test tubes containing 3 milliliters of YES liquid medium [3].
Authors: At what temperature do you incubate? Either 25 or 32 degrees depending on the yeast genotype. 
2.1.1. MEDCU: Talent adds solid medium to yeaststreaks yeast onto solid medium.
2.1.2. MED: Talent places the plates into incubator.
2.2. Then, use a sterile loop to pick cells from individual colonies in the awaken fission yeast strains [1] and inoculate them into test tubes containing 3 milliliters of YES liquid medium [2].
2.2.1. CU: Talent uses a loop to pick colonies.
2.2.2. CU: Talent places the loop into a tube containing medium.
2.3. Place the tubes in a shaker at 150-220 rpm to grow at 25 or 32XX degrees Celsius for XX days overnight [1] to the mid- or late-log phase with a desired optical density reading of 0.7-1.0 XXX [12]. Transfer XX 10 milliliters microliters of the culture to a XXX microscope slide, put a coverslip on, and place it under a microscope [23] to check the for proper cell morphology and nutritional state [34].
Authors: How do you determine nutritional state?
2.3.1. MED: Talent places the tubes into a shaker.
2.3.2. CU: Close up of a OD reading, showing 0.7-1.0
2.3.3. MED: Talent transfers culture and observes under a microscope.
2.3.4. SCOPE: Talent shows the cell.
2.4. To set up a microscope slide for mitosis or meiosis analysis, first add 2 grams of agarose in a 500-milliliter beaker containing 100 milliliters of either minimal medium plus supplements for mitosis, or liquid SPASsporulating medium for meiosis [1-TXT].
2.4.1. CU: Talent adds powder into a beaker with medium. TEXT: mitosis: minimal medium plus supplements; meiosis: liquid SPAS
2.5. Warm the agarose solution in a microwave oven at 60% power in 10- seconds increments [1] or place the beaker in a 55 degrees Celsius water bath for 10 minutes [2]. Swirl the solution to ensure efficient melting [3].
2.5.1. MED: Talent places the beaker in a microwave and adjusts settings.
2.5.2. MED: Talent places the beaker in a water bath.
2.5.3. CU: Talent swirls the beaker. Close up of the melted agarose.
2.6. Set up two microscope slides on a XX pipette tip holder with the top one slide resting on two stacks of sheets lab tape at both ends as support, making a cross shape [1]. Keep the distance between the two slides at XX millimeterAdjust the distance between the two slides to greater than 2 millimeters in order to form a thick pad in the following steps for prolonged imagings [2].
2.6.1. MED: Talent sets up a slide on a holder. Focus on the slides.
2.6.2. CU: Shot of the distance between the two slides. Video editor: place a ruler to show the distance.
2.7. After cooling the molten agarose for 1 minute at room temperature, remove the top slide, and use a wide-bore pipette tip to dispense 50-100 microliters on the bottom slide to make a spot [1]. Before the agarose cools down, place the top slide on top to generate a spread pad of about 1.5-2 centimeters in diameter [2]. 
2.7.1. CU: Talent removes top slide and dispenses the agarose on the bottom slide.
2.7.2. CU: Talent places a top slide on top.
2.8. Kuo-Fang Shen: Optimal live-cell imaging is critical for subsequent data processing steps. Ensure to eliminate any air bubbles from the molten agarose and create a thick pad for imaging periods longer than 4 hours [1].
2.8.1. INTERVIEW
2.9. To examine mitotic events, grow cells from starter cultures in either liquid EMM or PMG plus supplements for XX daysovernight [1]. Transfer XX milliliters1 milliliter of the culture into a cuvette and measure on the spectrophotometer at a wavelength of 595 nanometers [2]. The cell growth is considered mid-log phase when the OD595 optical density (pronounce as O-D-5-9-5) reaches 0.4 [3]. 
2.9.1. MED: Talent shows the starter culture.
2.9.2. MED: Talent transfers culture and measures on the photometer.
2.9.3. CU: Close up of the reading of the photometer showing 0.4.
2.10. Then, Centrifuge centrifuge 1 milliliter of the cell suspension at 1,375 times g for 1 minute [1], remove the supernatant and resuspend the cell pellet in the minimal medium plus supplements to a final volume of 100 microliters [2]. Mount cells for imaging as shown later for meiotic experiments. 
2.10.1. MED: Talent transfers 1 mL of the cell suspension into a tube, and places into a centrifuge.
2.10.2. CU: Talent removes supernatant and adds medium.
2.11. To image meiotic events, grow cells from starter cultures in the minimal medium plus supplements for XX daysovernight [1]. CThe cell growth is considered late-log phase when the optical density at OD595 nanometers is between 0.7 andto 1 [2].
2.11.1. MED: Talent shows the starter culture. [Perhaps it is best that talent shows inoculation from starter culture followed by cell density readings from the experimental culture].
2.11.2. CU: Close up of the reading of the photometer showing between 0.7-1.
2.12. Combine XX microliters500 microliters of each opposite mate-type cells, h- and h+, in a 1 milliliter cell suspension [1]. Centrifuge the cells at 1,375 times g for 1 minute [2], remove the supernatant and resuspend the pellet in XX milliliters1 milliliter of liquid maltose extract ME [3]. Repeat the maltose extractME wash thrice to ensure efficient nutrient removal [4-TXT]. 
Authors: Where do you obtain mate-type cells, h- and h+? Please provide full name for ME.In the fission yeast field, it is known that h+ and h- haploid cells of the same genotype must be mixed in limited nitrogen media to induce sexual reproduction. Thus, h+ and h- cells come from the same wake up plate and meet only after growth in liquid culture. 
2.12.1. MED: Talent adds two solutions into 1 mL cell suspension.
2.12.2. MED: Talent places the tube into the centrifuge. Videographer: Take multiple shots, as this will be used later. 
2.12.3. CU: Talent removes supernatant and adds medium. Videographer: Take multiple shots, as this will be used later.
2.12.4. Use 2.10.2. TEXT: Repeat wash thrice.
2.13. After the last maltose extractME wash, resuspend the cells in 1 milliliter of maltose extractME [1] and transfer the mixtureit to a 50-milliliter flask containing 9 milliliters of maltose extractME [2]. Incubate for 12-16 hours at 22-25 degrees Celsius on minimal rotation speed between 50-100 rpm [3].
2.13.1. Use 2.10.3.
2.13.2. MED: Talent transfers the cell suspension into a flask containing ME liquid.
2.13.3. MED: Talent places the flask on a rotator and adjusts the speed.
2.14. The appearance of many round fission yeast clumps resulted resulting from abundant cell flocculation indicates efficient mating [1]. Next, take 1 milliliter sample of the mating culture and centrifuge at 1,375 times g for 1 minute [2].
2.14.1. CU: Close up of the yeast clumps.
2.14.2. MED: Talent draws up 1 mL of the culture into a tube and places into a centrifuge.
2.15. Remove 750 microliters of the supernatant, and resuspend cells in the remaining supernatant [1]. Vortex vigorously for 5 seconds to disrupt the clumps [2].
2.15.1. CU: Talent removes 750 microliters and resuspends.
2.15.2. MED: Talent vortexes the tube and then shows it with no reduced clumps. [Coverslip rotation accomplishes the remaining clump disruption.]
2.16. Dispense 20 microliters of either a mitotic or meiotic cell suspension on a 2% agarose pad [1]. Remove any excess medium by inverting the slide and putting it on the top of a lint-free paper towel for 2-3 seconds [2]. Flip the slide and gently place a glass coverslip on the top of the pad, ensuring not to generate air bubbles [3-TXT]. 
2.16.1. CU: Talent adds cell suspension onto the agarose pad.
2.16.2. MED: Talent places the slide on paper to dry.
2.16.3. CU: Talent flips the slide and places a glass coverslip on top. TEXT: CAUTION: Avoid bubbles!
2.17. To create a cell monolayer, rotate the coverslip clockwise with the index finger for one full turn for mitosis cells [1], or two full turns for meiosis cells [12]. Ensure that the cell matter disperses across the agarose pad allowing for better separation of single cells or asci [23].
2.17.1. CU: Talent rotates the coverslip one full turn.
2.17.2. CU: Talent rotates two full turns.
2.17.3. ECU: Close up of the cell matters dispersed.
2.18. With the aid of a small wooden stick, dispense molten hydrocarbon sealant along the edges of the coverslip to seal each agarose pad [1]. Once the agarose pad is sealed, place it on the microscope stage [2]. and adjust the temperature and humidity of the microscope system [3].
Authors: What kind of sealant? How do you adjust temperature at the microscope stage?
2.18.1. MED: Talent seals the edges of the coverslip with sealant.
2.18.2. MED: Talent shows the sealed pad, and places onto the microscope stage.
2.18.3. SCREEN: Talent adjusts temperature and humidity.
2.19. Switch on the temperature chamber and set the dial for desired temperature around 25o C [1]. Place a plate with a wet paper towel into the chamber to control the humidity of the microscope system [2].
2.19.1. CU: Talent adjusts temperature of the microscope system.
2.19.2. MED: Talent places a plate with wet paper towel into the chamber.
2.20. Let it equilibrate for 10-15 minutes at the appropriate imaging conditions. This Allow allows any remaining air bubbles to dissipate and let any last-minute agarose shifts to occur [1].
Authors: In the previous step, you have ensured no air bubbles. Why here it has bubbles again?
2.20.1. CU: Close up of the agarose with bubbles dissipating.
3. Live-cell Imaging
3.1. Use the 40x objective to find appropriate fields of view to the image [1]. Switch to the 60x objective to begin data acquisition [2]. In the XX softwarsoftware that controls microscope functione, choose the microscope filter sets XXX, and XXX that best match the fluorophores under observation [3].

3.1.1. SCOPE: Talent finds appropriate fields.
3.1.2. MED: Talent switches lenses.
3.1.3. SCREEN: Talent chooses filter sets.
3.2. Adjust the excitation wavelengths to XXmatch the fluorophores used, employ the lowest excitation power at XX that produces a consistent signal, and use exposure times of 4-8 hours to generate acceptable, yet quantifiable and reproducible imaging data [1-TXT].
3.2.1. SCREEN: Talent adjusts excitation wavelengths, power, and exposure time. TEXT: Thick 2% agarose pads can withstand 12 to 16 h imaging sessions.
3.3. Collect at least 6 acquisition time points every hour [1]. On the XX, select XX to imageIn the image collection software, select at least one fluorescence channel from which to acquire datafluorescence protein, and employ a z-stack comprised of a z-stack per time point, and select XX to acquire the fluorescent channel comprised of 13 sections with 0.5-micrometer spacing [2-TXT]. 
3.3.1. SCREEN: Talent adjusts acquisition time points.
3.3.2. SCREEN: Talent adjusts settings. TEXT: A minimum of 0.5-1 GB of hard drive storage space. 
4. Image Analysis
4.1. In the Fiji software, upload a deconvolved image by selecting the Bio-Formats Importer feature under the Plugins menu [1]. In the Import Options pop-up window, select Hyperstack, Default color mode, check Autoscale, and press the OK button [2]. 
4.1.1. SCREEN: Talent uploads an image.
4.1.2. SCREEN: Talent adjusts settings in the pop-up window.
4.2. Ensure the displayed window has the correct number of fluorescence channels and time frames by scrolling sideways on the respective bars at the bottom [1]. Save as a Tiff file, which does not compress data [2]. 
4.2.1. SCREEN: Talent scrolls the bars at the bottom.
4.2.2. SCREEN: Talent saves the file.
4.3. Then, select Measure, under the Analyze menu [1], use the Set Measurements option to choose different parameters, for example, Area, Perimeter, Mean gray value, Median, Min & max gray value, Integrated density, Stack position, and Display label [2]. 
4.3.1. SCREEN: Talent navigates to Analyze menu.
4.3.2. SCREEN: Talent chooses parameters.
4.4. Select Color and click on the Channels ToolClick XXX. I, in the Channels pop-up window, check the color channel for which intensity or area will be measured [1]. Choose the Adjust and Threshold features under the Image menu. Check the Dark background box, select the Default method, and pick Red to overlay the signals of interest [2]. 
4.4.1. SCREEN: Talent selects color, and clicks on the Channels tool, and goes to channels pop-up window, and points to color channel.
4.4.2. SCREEN: Talent chooses two features, and adjusts settings. 
4.5. Use the Wand tool to highlight each structure of interest [1] and press the letter T on the keyboard [2] to add the selected ROI to the pop-up ROI manager window [3]. 
4.5.1. SCREEN: Talent highlights structure of interest.
4.5.2. CU: Talent presses T.
4.5.3. SCREEN: Talent shows the ROI manager window with added ROI.
4.6. Next, open the zipped ROI folder to load the ROI manager and click on each ROI identifier on the left side panel [1]. Select Measure from the Analyze menu and repeat this command on each ROI identifier to quantify the objects of interest in all slices of the image stack [2]. 
4.6.1. SCREEN: Talent loads the ROI manager, and clicks on the left panel.
4.6.2. SCREEN: Talent selects measure, and repeats for the rest ROI.
4.7. Save results as a csv file for statistical analysis [1]. 
4.7.1. SCREEN: Talent saves as a csv file. 




OPTIONAL – Critical Step Statement:
· An OPTIONAL brief statement may be submitted for further elaboration of the best way to perform the required technique for the single most critical step of this procedure. 
· If there is no single critical step, then there is no need to fill out this statement.
· This will be an interview style shot interjected after the relevant step within the Protocol section of the video. 
· This statement is limited to 30 words or less. 
· Please indicate the full name of the Author who will give this statement and the step of the protocol to which the statement pertains using the step numbers from the Protocol section (above).
Fill in the details below based on the instructions above for the “Critical Step Statement”
Author name, Step            :           (Write your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on camera)

Section - Protocol
Section – Results
The Results section is restricted to 200 words of narrative. Please read through the results as presented to make sure that it accurately represents your findings. If you would like to highlight other data, please revise this section accordingly, keeping in mind the word count restriction. Please note that we cannot include narrative without an accompanying visual. 

5. Results: Cell Selection, Mitotic and Meiotic Nuclear Dynamics
Authors: Please provide layered unflattened image for Figure 2.
5.1. In this study, if cells starve due to nutrient limitation or overgrowth, they will show excess vacuoles and decreased cell size [1]. Logarithmic cells show active DNA replication and cell division [2], as well as pan-nuclear Tos4-GFP expression, and Sad1-DsRed foci separation [3].
5.1.1. Figure 2 – Video editor: Emphasize Figure 2A, and the three top Starvation images.
5.1.2. Figure 2 – Video editor: Emphasize Figure 2A, and the bottom Log images.
5.1.3. Figure 2 – Video editor: Emphasize Figure 2A, and the bottom blue and green Log images.
5.2. Failure to mate, as is the case when cells are not sufficiently starved of nitrogen, will prevent them from entering meiosis [1]. A pair of vacuolar fission cells undergoing karyogamy are shown [2]. 
5.2.1. Figure 2 – Video editor: Emphasize Figure 2B, the top inefficient image.
5.2.2. Figure 2 – Video editor: Emphasize Figure 2B, the top inefficient image, and the pair of cells indicated by the arrow.
5.3. Robust flocculation of the mating cell suspension increases cell-to-cell interaction and thus indicates successful mating and efficient meiotic induction [1]. Zygotic asci take multiple forms including the zig-zag [2] and banana cell shapes [3].
5.3.1. Figure 2 – Video editor: Emphasize Figure 2B, the bottom efficient image.
5.3.2. Figure 2 – Video editor: Emphasize Figure 2B, the bottom efficient image, and the cell indicated by the red closed arrow.
5.3.3. Figure 2 – Video editor: Emphasize Figure 2B, the bottom efficient image, and the cell indicated by the red open arrow.
5.4. In mitosis, as cells transition from metaphase to telophase [1], the first change involves a contraction of nuclear size in metaphase [2], while the second shows nucleus splitting during anaphase [3].
5.4.1. Figure 3A&B – Video editor: Emphasize on Figure 3A, lanes 3-8. Emphasize on Figure 3B, 20-120min.
5.4.2. Figure 3A&B – Video editor: Emphasize on Figure 3A, lane 3. Emphasize on Figure 3B, at 20min.
5.4.3. Figure 3A&B – Video editor: Emphasize on Figure 3A, lane 4. Emphasize on Figure 3B, at 40min.
5.5. Besides sharing some these changessegregation dynamics with mitotic cells, meiotic cells exhibit nuclear oscillation [1] during homologous recombination and further reduction of nucleus size at the end of anaphase two [2].
5.5.1. Figure 4 – Video editor: Emphasize -100’ to -50’, on both Figure 4A&B.
5.5.2. Figure 4 – Video editor: Emphasize the 70’ to 90’, on both Figure 4A&B.
5.6. 


Section - Conclusion
Section - Conclusion
6. Conclusion Interview Statements: (Said by you on camera) - All interview statements may be edited for length and clarity.
7. 
· Below are questions for statements that can be used to further emphasize the significance of your protocol. At least one statement is required.
· Each statement is limited to 30 words.
· Answer the questions in full sentences, as you will be expected to memorize and deliver the sentences as spoken interview statements during filming. 
· Indicate the full name of the author who will give each Conclusion Interview statement. 
What is most important thing to remember when attempting this procedure? Please indicate the steps (e.g., 2.4., 2.5.) in the Protocol section this advice correlates to.
7.1. Author NameKuo-Fang Shen: ____ (Step: __) (It is the responsibility of researchers to ensure that experimental parameters can be reproduced across experiments and that the collected data is fit for downstream analysis [1].
7.1.1. INTERVIEWWrite your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on camera)
Following this procedure, what other methods can be performed? What questions would these additional methods answer?
7.2. Author Name: ____ (Write your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on camera)
After its development, did this technique pave the way for researchers to explore new questions within a specific scientific field? If so, how?
7.3. Author NameSusan L. Forsburg: ____ (Write your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on cameraLive-cell imaging has allowed researchers to observe in close detail the mechanics of nuclear division during mitosis and meiosis. As fluorescent tags and microscope capabilities improve, so will the number and type of nuclear processes that we can examine increase [1].
7.3.1. INTERVIEW)
Are any of the reagents or instruments hazardous? If so, please use this interview statement to remind viewers of what precautions they should take.
7.4. Author Name: ___(Write your answer here in the form of a spoken statement. Don’t forget to replace “Author Name” with the name of the person who will be speaking the statement on camera)

Thank you for following the instructions and addressing our questions. We will incorporate your answers/suggestions and send you the finalized script before your shoot. You will also receive detailed shoot preparation instructions in the email accompanying the finalized script.
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